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1. Introduction 

 

WatchLock Cube is a versatile, user-friendly, smart reporting padlock that 

keeps you updated in real time. WatchLock Cube is the latest version of the 

award-winning WatchLock padlock, which combines advanced GPS and GSM 

technology with a versatile locking system. 

It provides notifications in real time upon any predefined irregular event, acting 

both as a security measure and a monitoring solution. WatchLock Cube 

protects your assets and communicates with you no matter where you or your 

assets are. 

WatchLock Cube is equipped with high-end electronic components; its battery 

capacity is increased fourfold compared to that of WatchLock. The Cube’s 

electronic shell can fit a variety of C10 padlocks from various manufacturers. 
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2. Package Contents 

 

 

1. WatchLock Cube with protective rubber cover 

2. Keys 

3. WatchLock Cube programming cable (optional) 
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3. Product Description 

 

WatchLock Cube is a combination of an electronic tracking device with GPS 

locating system, cellular-based communication capabilities, and a padlock. 

Together they provide immediate triggered alerts and location information 

through email, a web-based monitoring system, or a smartphone app. 

This manual describes how to configure and monitor the WatchLock Cube 

device. 

 

Audible signals 

The device uses audible signals (beeps) to announce its activity. When you 

insert the programming cable or the batteries in the device, it will sound one 

(1) audible signal (beep), to indicate that it was activated. 

After this, the device will connect to the cellular network. Once the device 

performs a successful connection to the cellular network, it will sound two (2) 

audible signals (beeps). 

At the same time, the device will connect to the GPS and get the location. Once 

the device performs a successful connection to GPS, it will sound three (3) 

audible signals (beeps). 

The device will sound four (4) audible signals (beeps) when its batteries are 

getting empty. 

When the shackle is connected to the tracking device and the lock is being 

locked / unlocked, the device will sound one (1) short audible signal (beep). 
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Technical specifications 

Location 

 

Type 

Time to First Fix (TTFF) 

Positioning Accuracy 

Velocity 

Antenna Type 

GPS, GLONASS (optional) 

12 sec. (hot start) 

10 m CEP (50%) 

0.2 m/s (50%) 

Built in (concealed) 

Environmental 

Specifications 

Operating Temperature 

Storage Temperature 

-20°C to +60°C 

-40°C to +85°C 

CPU 

 

Static RAM 

Non-volatile Memory 

Flash Memory 

128 KB 

34 KB 

2048 KB 

Battery 

 

Type 

 

Power 

 

4 AA batteries (rechargeable / 

non-rechargeable) 

Varies by type of AA batteries 

used. It is the capacity of a single 

AA battery used multiplied by 0.8 

GSM 

Communication 

 

Type 

 

Networks 

GSM: 850/900/1800/1900 

SMS, GPRS, HSDPA 

850/900 class 4 (2 Watt) 

1800/1900 class 1 (1 Watt) 

Physical 

Specifications 

 

Dimensions 

 

Weight 

7.5 x 7.5 x 8 cm (17 cm with C2 

shackle) 

910 g (padlock included) 

Accelerometer 

 

Type 

Purpose 

3 Axis, 0.1g resolution 

Identify and report events of 

impact 

Access Port Type USB 

Power 

Consumption 

(mA) 

 

Sleep/Idle 

GPS only 

GPRS only 

GPS and GPRS 

0.5 

105 

80 

165 
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4. Configuration 

 

Downloading the software 

For the link to download the Installer application setup file, please contact 

Starcom technical support by Email: support@starcomsystems.com, or 

Skype: starcom.support. 

 

Installing the software 

Locate the folder where you saved the installer setup file. Double-click the 

InstallSetup.exe. A Windows Defender window appears. Click More info. 

 

  

mailto:support@starcomsystems.com
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Click Run anyway. The Select Destination Location window appears. 
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Click Next. The Select Components window appears. 

  



 
 

12 

WatchLock Cube User Guide 

Click Next. The Select Start Menu Folder window appears. 

 

 

NOTE: Select Don’t create a Start Menu folder checkbox, if you do not want 

to create a start menu folder. 

 

Click Next. The Ready to Install window appears. 

 

  



 
 

13 

WatchLock Cube User Guide 

 

Click Install. The installation starts, and a progress bar appears in the window 

indicating the progress of the installation. 
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When the installation is complete, the Completing the Starcom Installer 

Application Setup Wizard window appears. 

 

Click Finish. 
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Installing the update 

To install the Installer update software, locate the folder where you saved the 

update file. Double-click IUpdate.exe. The Starcom Installer Update window 

appears. 

 

 

Verify that the Destination folder points to the location where the Starcom 

Installer software is installed and click Extract. 
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A Confirm file replace dialog box appears. Click Yes to All. 

 

 

The installation starts, and a progress bar appears in the window, indicating 

the progress of the installation. 
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The Starcom Installer Update window closes, when the update is complete. 

 

Installing the cable driver 

The WatchLock Cube cable driver can be downloaded from the following 

location: 

http://www.ftdichip.com/Drivers/VCP.htm 

Download the driver for the proper Windows version. 

The driver Installation Guide can be found at the following location: 

http://www.ftdichip.com/Support/Documents/InstallGuides.htm 

Download the Installation Guide for the proper Windows version. Follow the 

instructions in the Guide to install the cable driver. 

 

  

http://www.ftdichip.com/Drivers/VCP.htm
http://www.ftdichip.com/Support/Documents/InstallGuides.htm
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Disassembling the device 

Use the key to open the lock and remove the shackle. 
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Remove the rubber cover from the device. 
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Pull the plastic cover to remove it from the device. 
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Use a cross-head screwdriver to remove the two screws in the top cover. 
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Remove the top cover. 

 

Carefully pull and slide out the battery holder. 
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ATTENTION!  
 
Be careful when taking out the battery 
holder. Do not tear the wires. 
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Use the cross-head screwdriver to remove the two screws underneath the 

battery holder. 
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Pull the top part to disassemble the device and reveal the lower part with the 

SIM card holder. 
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Inserting the SIM card 

Gently push and pull back the plastic SIM card holder to release and open the 

SIM card slot. 
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Insert the SIM card into the SIM card slot with its gold contacts facing you and 

its cut-off corner facing out the SIM card slot, as shown in the following image. 
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Put the SIM card holder back into vertical position. Gently press and push the 

SIM card holder forward to snap it back into place. 
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Connecting the device to the computer 

Connect the programming cable connector to the USB port on your computer. 

Connect the 5-pin connector to the device.  

Make sure that the slot on the device connector socket corresponds with the 

bulge on the cable connector plug.  

The three (3) pins on the cable connector plug must point upwards and the 

two (2) pins downwards. 
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Configuring the device 

To open the Installer application, from the Start menu select Starcom 

Systems > Installer Application. The Installer company name window 

appears. 

 

 

Enter your company name and click OK. The Wizard window appears. Unclick 

the Always show this wizard on program startup option and press 

Cancel. 
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The Installer window appears. 

 

 

Click Technical > Communications or press the Communications button 

 on the taskbar at the top of the window. 
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Click the Advanced button . The Communications Window will 

appear. 

 

 

Click the Add button . The Network Selection window appears. 

 

 

 

Select Helios from the list and press OK to add a Helios network. 
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The Communications Window will now display the new connection in the 

Available Networks list, which is named Helios 1. (The name "Helios" in this 

case of the device connection to the Installer applies globally to all device 

types). 

 

Click on Helios.1 button to configure and activate the connection. 
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Select the COM port number of the WatchLock Cube cable port in the Com 

Port menu. 

To verify the COM port being used by WatchLock Cube in your computer, go 

to My Computer > Manage > Device Manager > Ports. 
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Set the Baud Rate to 115200 (default). Check the Activate checkbox and 

click Save. 

 

 

 

If WatchLock Cube has connected successfully, a "Helios.1: on" notification will 

appear in green color at the bottom left corner of the Installer application main 

screen . 
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To access the device parameters, press Technical > Watchlock 

Parameters, or right click on the taskbar at the top of the Installer application 

window and press Customize. Select Watchlock Parameters and drag/drop 

it into the taskbar. Press Close. 

 

 

 

Press on Watchlock Parameters and use the settings to configure the device. 
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Press the Read from device button  to read the parameters 

already configured in the device. 
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Network settings 

This tab allows you to enter all the parameters necessary for the device to 

connect to the network. 

 

 

SMS Destination 

The device transmits via GPRS by default and via SMS as a backup, when GPRS 

connection is not available. The number to be entered in the SMS Destination 

field is the SIM card number used in the SMS Terminal device connected to the 

routing server or the SMPP target number. For more information, see SMS 

Notifications guide. 

 

APN settings 

The APN settings are essential in order for the device to transmit messages 

and alerts. The APN settings are provided by your cellular operator with the 

SIM card you are using in the device. 

GPRS APN (Access Point Name) – the name of the gateway provided by your 

cellular operator (e.g., internet). 

GPRS Username – username provided by your cellular operator (e.g., blank).  
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GPRS Password – password provided by your cellular operator (e.g., blank). 

 

First server – main routing server, which the devices transmit to (by default, 

it is Starcom Systems server 1). 

Secondary server – auxiliary routing server, which the devices transmit to 

(by default, it is Starcom Systems server 2). 

Port – port open for communication on the routing server (default port is 

6600). 
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Transmission Rates settings 

This tab allows you to configure the intervals of regular tracking transmissions 

which define how often the device will transmit its status. 

 

 

Transmission – interval of regular tracking transmissions which defines how 

often the device will transmit its status. 

GPS Peek – interval of the GPS update which defines how often the device’s 

GPS module will update its location. 

Transmission and GPS Peek values are usually left the same. In some 

instances, these parameters can be configured with different values. For 

example: 

GPS Peek can be faster than Transmission when between the regular 

transmissions the device can enter or exit a specified perimeter. In such case, 

a Perimeter event created on Starcom Online will be triggered by the change 

in the device location. For more information, see Chapter 7 – Monitoring. 
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GPS Peek can be slower than Transmission when the device is installed in a 

remote location for long periods of time, when the GPS update is not really 

required. In such case, Transmission can be set for 1 day, for example, and 

GPS Peek can be set for 5 days (highest value) to save battery power. 

For the testing period, you can set the transmission rates at a higher interval 

(e.g., 10 minutes). Once the device is tested, you can set the transmission 

rate at a proper working interval (e.g., 5 hours). 

Transmission rates also determine how long the battery will stay charged. 

Every transmission uses the battery. The faster the transmission rate, the 

faster the battery will end. 

Note that these are the regular scheduled Tracking transmissions and they do 

not include the additional random transmissions and alerts, like Open/Close, 

Location Update, etc., which also use the battery. 

Logging – interval of data logging, during which the device will wake up only 

for a few seconds to record its current state but will not transmit (useful for 

temperature / light logging). The information will be transmitted along with 

the next transmission (tracking/opening/etc.). 

Only when weak impact detected – when enabled, tracking messages will 

only be sent if during the selected period a weak impact was detected. 

NOTE: This will disable the weak impact transmissions. 

Standby – if "Only weak impact is detected" is enabled use this setting to set 

the tracking rate when the device is stationary. This interval must be slower 

than the Transmission rate (e.g., use 1 day as Standby and 15 minutes for 

Transmission). 

No movement – time without movement before a “No movement” alarm is 

sent. Recommended to be used together with the “Only when weak impact 

detected” setting above. 
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When the device is out of GPRS coverage, the messages will be saved to the 

device memory. Messages saved in the memory can be sent when the device 

resumes the connection to home cellular network, or to the roaming network, 

if the SIM card used in the device has a roaming service enabled by your 

cellular provider. 

SMS – select this option if you want the device to transmit messages saved in 

the memory via SMS. The device transmits by GPRS by default and by SMS as 

a backup when GPRS connection is not available. For more information, see 

Appendix A – Device Communication in Starcom Systems. 

Roaming GPRS – select this option if you want the device to transmit 

messages saved in the memory via roaming GPRS. In order for this to work, 

the SIM card used in the device must have a roaming service enabled by your 

cellular provider.  



 
 

44 

WatchLock Cube User Guide 

Hardware settings 

This tab allows you to configure various hardware settings. 

 

Watchlock Cube – activate this option in order for the device to function as 

WatchLock Cube. 

Monitor "Break-in" events – not applicable to WatchLock Cube. Do not use. 

Location updates – GPS enabling option. Once activated, the device’s GPS 

module will be turned on upon every transmission, and location update 

transmissions will be sent. 

Location by Cellular – when enabled, location lookup will be done according 

to cellular antennas if GPS is not available. 

Filter inputs – when enabled, the switches status will be changed only after 

2 seconds of continuous state. 

Debugging beeps – factory testing setting. Do not use. 

Transmit after first start-up – if this option is activated, a "Power On" 

message will be transmitted whenever the device is powered on for the first 

time or gets restarted.  
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Use A-GPS – when enabled on supported devices, Assisted GPS data will be 

downloaded from the GPRS to get better and faster GPS fix. 

Weak Impact / Strong Impact –accelerometer parameters used to define 

two types of impact (hit, push, drop. etc.) on the device. 

Force (g) – determines the threshold of the force needed to be measured in 

order to send an alert. Select "Disabled", if you don't wish to use the alert. 

Duration (msec) – determines the duration of the force needed to be 

measured in order to send an alert. 

The default values configured in the device are based on the laboratory testing 

results, they were found to be acceptable in most cases. These values can be 

tested and changed according to the specifics of your work. To change these 

values according to specific conditions, you need to test the device with 

different values and choose the best option. The lower the setting, the more 

often the device will respond to a weaker impact. 

Inductive lock / unlock – not applicable to WatchLock Cube. Do not use. 

 

Once all the necessary parameters are set, press the Send button 

 to send the changes you made to the device. 
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Saving the configuration 

If you are planning to configure other devices with the same parameters, you 

can save these settings as a *.mem file. Click the Save button  in 

the Watchlock Parameters window, select the location where you want the 

configuration file to be saved on your computer, name the file and press Save. 

 

Configuring a new device with the saved configuration 

To configure a new device with the saved parameters, click the Load button 

 in the Watchlock Parameters window, browse to the location where 

you saved the configuration file, select the file and press Open. Click the 

Select All button  to select all the parameters and press the 

Send button  to send the changes to the device. 
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5. Testing 

 

It is important to test the device connection to the network, the correct GPS 

location, the device status and inputs response before installing the device. To 

do this, you need to perform the following steps. 

 

TCP test 

This test verifies that the SIM card is open to the GPRS network, the device 

can connect to the network and make successful TCP/IP transmissions. 

Press the TCP Test button  (Communications > Advanced 

> Communication Window > Configuration > Helios.1). Wait a few 

minutes until you receive a pop-up window with a successful connection 

message. 

 

If at the end of the TCP Test you do not receive a successful message, check 

your APN settings (Watchlock Parameters > Network). Contact your cellular 

provider and make sure the SIM card is open for GPRS. Verify that your SIM 

card is not protected by a PIN code. If necessary, use a mobile phone to cancel 

the PIN code. 

You can also perform the test manually using the Terminal window. Open the 

Terminal window (Communications > Advanced > Communication 

Window > Configuration > Helios.1 > Open Terminal) and type the 

following commands: 

\tdm and press Enter (Modem mode). The modem will be turned on. 

\tr and press Enter. This command runs a series of actions to check the 

parameters such as reception level, visible networks and registered network, 

SIM card state and information. It also attempts to connect to the routing 

server. If successful, a "TCP: Send+" message will appear in the Terminal 

window.  
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GPS test 

NOTE: If you're testing the device inside the building, it will not be able to get 

a GPS signal in most cases. In order to get a proper GPS location, the device 

has to be placed outside the building, or outside the window, where it can 

access the satellites. 

Open the Terminal window (Communications > Advanced > 

Communication Window > Configuration > Helios.1 > Open Terminal) 

and type \tdg (GPS mode). GPS readings will be displayed. When you see 

"A,3"... reading, it will indicate a GPS fix signal. 
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If you do not see any response, type \tg1 to turn the GPS on and repeat the 

test. 

 

Unit Status 

Open the Unit Status window. Enter the device number in the Unit Number 

field, select Request status and press Send. The device information will 

appear. 

 

 

Click on the Inputs tab, press Request status and check the response in the 

Device Status window. Use the Location tab to check the device’s GPS data. 

Use the Various tab to see the device information. 

After all the tests have been performed successfully, the unit is ready to be 

installed. 
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6. Installation 

 

Assembling the device 

Slide the top part onto the lower part of the device. 
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Use the cross-head screwdriver to screw back the two screws underneath the 

battery holder. 
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Carefully slide the battery holder back in its place. 

 

  



 
 

53 

WatchLock Cube User Guide 

Place the wires back in the track. If necessary, use a small, flat screwdriver to 

carefully fixate the wires. 
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Place the top cover back and use the cross-head screwdriver to screw back the 

two screws. 
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Inserting the batteries 

NOTE: WatchLock Cube uses four (4) standard AA batteries. You can use either 

rechargeable or non-rechargeable batteries. Before installation, please verify 

that the batteries are fully charged. 
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Carefully insert each battery according to the polarity markings on the battery 

holder, ensuring that the + (plus) and – (minus) terminals are aligned 

correctly. 
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Slide the plastic cover back onto the device. 

 

 

  



 
 

59 

WatchLock Cube User Guide 

Place the rubber cover over the device, insert the shackle back into the device 

and use the key to close the lock. 
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The device is now ready for installation. 
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7. Monitoring 

 

After the device is installed, you can monitor its status on Starcom Online. 

Starcom Online is a web-based fleet management application with a flexible 

event generator, which allows to set customizable notifications and alerts. 

In your browser, go to http://www.starcomsystems.com/online. Enter your 

username and password in the Username and Password fields, and click 

Sign in. 

 

Starcom Online horizontal menu bar features the following categories: 

• Home – lists the most recently accessed devices, including their 

location. 

• Resources – allows to manage the device and customer information. 

• Plans – allows to create and manage events and alerts. 

• Monitor – monitors the events and alerts from the device. 

• Map – displays the actual location of the device on the map. 

• Reports – generates reports of the device activity. 

• Profile – allows to configure your user properties. 

• Help – contains tutorials and knowledge base. 

  

http://www.starcomsystems.com/online
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Home 

The Home section shows recently accessed devices and latest site updates. 

 

In the Home section, you can find the following additional links: 

Live status – displays the current status of all live devices, as shown in the 

following image. 

 

Full list – opens the Resources section that displays a full list of all your 

devices. 

Location – opens the Map section that displays a map showing the current 

location of the device. 

Quick List – links that enable you to access the Resources and Plans sections. 
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Resources 

The Resources section shows all your devices. 

 

On the left side, the Resources section features the following tabs: 

Units – lists the devices. 

Groups – lists the groups of devices and helps you create new and modify the 

existing groups. 

Users – lists the users and helps you create new and modify the existing users. 

Places – lists perimeters and helps you define new and modify the existing 

perimeters. 

 

Units 

The Units page features the Details area, which arranges the device 

information in the following columns: 

Number – the device serial number. Clicking on the device number link 

will display the Unit Information page, where you can modify the 

device information. 

Name – displays the icon and the name of the device. Clicking on it will 

reveal a pop-up menu with the quick access links to the Map and the 

Reports sections. 

Cellular Number – displays the phone number of the SIM card installed 

in the device. 

Last Message – displays the time and date of the last message 

transmitted by the device.  
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To create a new device, click New (not available for evaluation kit 

users). The Unit Information page opens. 

 

Active – when selected (set by default), makes the device active on 

Starcom Online. To make the device inactive, deselect this checkbox. 

No data will be collected for inactive devices; they will appear as dimmed 

in the devices list. 

Use this section to enter the device Number and Name. In the Cellular 

Number field, enter the country code or the number of the SIM card 

installed in the device. 

In the Unit Type list, select Watchlock Cube. 

No Activity Alert (Hours) – used to receive an alert when the device 

has stopped transmitting. The default value is 336 hours (2 weeks). 
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In the Users window, click on the plus (+) sign on the right and start 

typing the name of the user you want to make the device available for 

in the Search field. The name of the user will appear in the dropdown 

list. Click on it to add it to the Users list. To remove the user, click on 

the minus sign (-) on the left of the user name. 

In the Groups window, click on the plus (+) sign on the right and start 

typing the name of the group you want to make the device available for 

in the Search field. The name of the group will appear in the dropdown 

list. Click on it to add it to the Groups list. To remove the group, click 

on the minus sign (-) on the left of the group name. 

When finished, click Apply. The new device is saved. 

 

To modify a device, in the Units page, click on the device name link of 

the device you want to modify. The Unit Information page appears. 

Modify the device details as required. Click Apply. The modified device 

details are saved. 

To delete a device, in the Units page, click on the device name link of 

the device you want to delete. The Unit Information page appears. Click 

Delete. The device is deleted. 
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Groups 

You can create new and modify the existing groups of devices. 

 

To create a new group, click New. The Group page opens. 

 

In the Name field enter the name of the new group. 
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In the Units window, click on the plus (+) sign on the right and start 

typing the name of the device you want to make the device available for 

in the Search field. The name of the device will appear in the dropdown 

list. Click on it to add it to the Units list. To remove the device, click on 

the minus sign (-) on the left of the device name. 

In the Users window, click on the plus (+) sign on the right and start 

typing the name of the user you want to make the device available for 

in the Search field. The name of the user will appear in the dropdown 

list. Click on it to add it to the Users list. To remove the user, click on 

the minus sign (-) on the left of the user name. 

In the Sharing section, click the respective checkbox, if you want the 

group to Share Perimeters or Share Events. 

Click Apply. The new group is saved. 

 

To modify a group, in the Groups page, click on the group name link of 

the group you want to modify. The Group page appears. Modify the 

group details as required. Click Apply. The modified group details are 

saved. 

To delete a group, in the Groups page, click on the group name link of 

the group you want to delete. The Group page appears. Click Delete. 

The group is deleted. 
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Users 

You can create new and modify the existing users. 

 

 

To create a new user, click New. The Users page opens. Here you can 

enter the new user information and define their access permissions. 
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Besides entering the user information, you can select the following 

options: 

All units –all the user’s devices will be displayed on the Map page. If 

this option is disabled, only the selected device will be displayed. 

Show coordinates in reports – the user’s reports will include the GPS 

coordinates. 

Show battery voltages – displays the battery charge in volts. 

Report Access – allows to select which reports will be accessible for 

the user. 

Google Maps access – enables Google Maps access on the Maps page. 

Allow status requests – enables the user to make device status 

requests. 

Allow outgoing commands – enables the user to send commands to 

the devices. 

Allow changing tracking interval – enables the user to change the 

devices' tracking interval. 

Allow set unit parameters – enables the user to change the devices' 

settings. 

Allow adding the units using QR code (Mobile) – enables the user 

to add a new Zeppos device in Olympia Tracking app. 

Allow stopping vehicle – enables the user to send a Gradual Stop 

command to the device. 

Allow logic state changing – enables the user to change the devices' 

Logic State. 

Allow clearing fleet – enables the user to send a Clear Events 

command to the devices. 

Cellular Commands – enables the user to send commands to the 

device from a cellular phone. 

Cellular Notification – enables the user to receive cellular 

notifications.  
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Lock account after 5 bad login attempts – locks access to Starcom 

Online account after the user has made 5 bad login attempts. 

Force password changing once a month – requires the user to 

change the password once a month. 

Allow editing cellular number – enables the user to edit the phone 

number of the SIM card installed in the device. 

Add Users – allows to create new users. 

 

Permissions allow you to define the viewing and editing permissions of 

the user for all the sections of the site. 

 

After you configured all the parameters, click Apply. The new user is 

saved. 
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To modify a user, in the Users page click on the user name link of the 

user you want to modify. The Users page appears. Modify the user 

details as required. Click Apply. The modified user details are saved. 

To delete a user, in the Users page click on the user name link of the 

user you want to delete. The Users page appears. Click Delete. The 

user is deleted. 
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Places 

You can create new and modify the existing perimeters. 

 

To create a new perimeter, click New. The Perimeters page opens. In 

the Name field, enter a name for the new perimeter. 

 

 

 

To create a new perimeter, click on the settings icon in the lower right 

corner of the map, Options > Create new perimeter at the top right 

corner of the map. Click once anywhere on the map to start the 

perimeter selection (this point would be the top left corner of the 

perimeter). Move the mouse and click again anywhere on the map to 

finish the perimeter (this point would be the bottom right corner of the 

perimeter). 
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In the Perimeter Name field, enter the name of the perimeter. Click 

Ok. The new perimeter is saved and appears on the map. 

 

To view/edit the GPS parameters of the perimeter, use the Longitude, 

Latitude fields on the left. 
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Modify the values as required. Click Apply to save the changes. 

 

After you made all the changes on the Perimeters page, click Apply. 

The perimeter details are saved, and the new perimeter appears in the 

list on the Resources section. 

 

To modify a perimeter, in the Places page click on the perimeter name 

link of the perimeter you want to modify. The Perimeters map page 

appears. Modify the perimeter as required. Click Apply. The modified 

perimeter is saved. 

To delete a perimeter, in the Places page click on the perimeter name 

link of the perimeter you want to delete. The Perimeters map page 

appears. Click Delete. The perimeter is deleted. 
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Plans 

The Plans section enables you to create usage plans and to view plans that 

already exist. 

 

On the left side, the Plans section features the following tabs: 

Basic – allows to set up basic plans for LCU500 devices. Do not use. 

Events – allows to create events for your devices. 

 

To create a new event, you need to create an event Type first. Click Types. 

The Types page opens. 

 

In this section, you can see the types of events already created in the system. 

You can use one of them or create a new type. 
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To create a new event type, click New. Enter the name of the event type in 

the Name field. Leave Day of the week and Time Range as "Changeable", 

later you will be able to change these settings in the event itself. 

 

Click the Add Event button and select the event type you want to create from 

the dropdown list. 
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Most of the types listed here relate to the Helios devices. The event types that 

can be used for WatchLock Cube are: Wait, Perimeter, Roaming, GPRS, 

Tracking, Logic State and Transmit Reason. 

Set the necessary Value. You can leave the Condition as "Changeable", later 

you will be able to change it in the event itself. Select the necessary operand 

in the Operand list, as follows: 

And – when you create several events, this event and the following one will 

be performed simultaneously. 

And then – when you create several events, the following event will start only 

after the first one is performed. 

Transmit – the event will be transmitted. 

End – ends an event. For example, you can create an output event, which 

after it performs the necessary actions will simply end. 

You can create a complex event type, which consists of several events. 

When finished, click Apply. The new event type is saved. 

 

To create a new event, click New in the Events section. 

 

 

Enter the name of the event in the Name field. In the Units list, select the 

devices you want to include in the event and click Add. The devices will be 

moved to the Available for list. 
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Enter the email address to receive the event notification. If you select the 

Monitor checkbox, the event will be displayed on the Monitor page (see below) 

in real time. 

Click the Add Event button and select the type of the event you want to create 

from the dropdown list. 
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Specify the time and date range and the event condition. 

When finished, click Apply. The new event is saved. 

 

For example, let’s create an event which will send an alert when the device 

enters a specific location. 

For this, we will use a Location event type already created in the system and 

create a new event based on this type. 

Go to Events and click New. 

 

 

Enter the name of the event in the Name field. In the Units list, select the 

devices you want to include in the event and click Add. The devices will be 

moved to the Available for list. 

Enter the email address to receive the event notification. Select the Monitor 

checkbox, if you want the event will to be displayed on the Monitor page in 

real time. 

Click the Add Event button and select the Location type in the Type list. 
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Enter the name of the event in the Name field. Select the necessary time and 

date range. 

Select the necessary perimeter in the Perimeter list. 

Select Entering in the Condition list. 

Click Apply. The new event, which will send an alert when the device enters a 

specific location, is created. 
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Monitor 

The Monitor section allows you to select a set of events for a specific device 

type and to see them displayed in real time. 

 

 

On the left side, the Monitor section features the following tabs: 

Monitor – displays the events in real time. 

Settings – allows creating new and modifying existing monitoring events. 

To create a new perimeter, go to the Settings tab and click New. The Details 

page opens. In the Name field, enter a name for the new event. 
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Select Watchlock/Kylos/Kylos Compact in the Unit Type list. 

In the Units list, select the devices you want to include in the event and click 

Add. The devices will be moved to the Available for list. 

In the Available reasons list, select the reasons you wish to receive an alert 

for and click Add. The reasons will be moved to the Notify for list. 

• Tracking – alerts on every regular transmission. 

• Event – alerts on every event created in the Plans section. 

• Emergency – not applicable to WatchLock Cube. 

• Low battery – alerts you of the battery getting low. 

• Static Pin IN/OUT – not applicable to WatchLock Cube. 

• Mobile Pin IN/OUT – not applicable to WatchLock Cube.  
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• Weak / Strong Impact – events which show two types of impact 

on the device. These events are triggered by the accelerometer, 

which can be configured in Installer > Watchlock Parameters > 

Hardware. 

• Location Update – event which will update you on the device 

location status. 

• Closed / Opened – alerts triggered upon opening and closing of 

the lock. 

• Maintenance – not applicable to WatchLock Cube. 

• Break-in – not applicable to WatchLock Cube. 

• Power on – alert that is sent when the device turns on. 

• Light On/Off – not applicable to WatchLock Cube. 

• Temperature Low/High/Normal – not applicable to WatchLock 

Cube. 

• Logging – alerts on every logging transmission. 

• No activity – this event can be used to receive alerts when devices 

have stopped transmitting. The default value is 336 hours (2 

weeks). 

 

Enter the email for the notification to be sent to in the Notify for section. 

Press Apply. The new monitoring event is saved. 

 

Once the events are generated by the devices, they will appear on the Monitor 

page. The email notifications are accumulated and sent once every half an 

hour to avoid spamming. 
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Map 

The Map page displays the location of a single device, or a group of devices. It 

also shows the device information and commands. 

 

 

You can select a device, or a group of devices in the dropdown list on the left. 

In the Search field, you can enter the device number to be displayed. 

Once you select the device, its location will be displayed on the map and its 

information will appear on the left. 
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The following device information is displayed: 

• Location – the address of the last GPS position of the device 

• Received – the date and time of last transmission from the device 

• Reason – the reason for the transmission 

• Version – the device firmware version 

 

• Location – the GPS location of the device, including: 

▪ Valid – the date and time of the last location transmission from the 

device 

▪ Coordinates – the GPS coordinates of the last position of the device 

▪ Altitude – the last altitude of the device  



 
 

87 

WatchLock Cube User Guide 

• IO – device input / output information 

 

• Commands 

▪ Request Status – requests the current status of the device 

▪ Tracking – overrides the device transmission rate settings and 

forces the device to transmit according to the specified interval. 

▪ Stop Tracking – stops the tracking command and returns the device 

to its regular transmission rate 

▪ The Queued commands option allows you to send a command to 

the device while it is in sleep mode. The next time the device wakes 

up to transmit, it will receive the command. This can be used to 

change the device tracking interval, for example. 

 

 

 

To enable the queued command, select the command and then press 

the plus (+) icon on the right. 

To remove the queued command, press the x icon on the right. 
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Click on the settings icon in the bottom left corner to reveal the Map Options. 

• Search – as you type the name of a search criterion in the search field, a 

list of matching names, from which you can select the required name, 

appears. 

• Create new perimeter – allows to create a new perimeter. 

• Edit perimeter – allows you to edit an existing perimeter. 

• Distance measurement – allows to measure the distance between two 

points on the map. 

• Shapes – displays your perimeters on the map. 

• All units – displays all your devices on the map at once. 

• Map types – you can select the following map types: OpenStreetMap, 

Yandex, ESRI Imagery, Google RoadMap, Google Satellite, Google Hybrid.  
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Reports 

The Reports section allows you to generate different device reports and to 

schedule automatically generated reports. 

 

 

On the left side, the Reports section features the following tabs: 

Instant – allows to generate reports on demand for a single device or a group 

of devices for a specific time period (date and time range). 

Schedule – allows to define scheduled reports that generate automatically on 

a daily, monthly or weekly basis. 

 

You can generate the following types of reports: Work Hours, Work Hours 

Summary, Work Hours Group Summary, History, History – Technical, 

Violations, Live Status, Events, Perimeter Entry, Transmit Reasons, 

Monitored events, Stops. 

 

To generate a report, select the report type in the Report dropdown list. Select 

the device or group of devices in the Unit dropdown list. Specify the dates and 

times in the Date Range. Click Generate. 

 

The following is an example of a report generated for one device on one day 

and for a specific time period. 
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The report includes a map area and tracking details area. The map area shows 

a map of the area in which the device is located showing points of movement 

of the device. The tracking details area lists the tracking data of the device. 

The pointers on the map correspond with the numbers in the address column 

of the detailed list of transmissions received from the device. These numbers 

indicate the points of movement of the device. The total number of map 

pointers available per report is 50. 

On the bottom of the Map section there is a Play button  that enables you to 

play back the movement of the device on the map. 

 

To save the report, click Save . The report is saved as a PDF file, or 

as an HTML file in a zip. 

To export a report, click Export . The report is exported as a CSV 

file, which can be viewed in Excel. 

To print a report, click Print . The report appears in your default 

browser window where you can select the printer to print out the report. 

 

 

Scheduled reports 

To create a scheduled report, in the Reports section, click Schedule. 

The Schedule page appears. 
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Click New. The Report Scheduling page opens. 

 

From the Report dropdown list, select the type of report you want to 

create. 

Tick the CSV only checkbox, if you do not want a map provided with 

the report. 

From the Unit dropdown list, select the device or group of devices for 

the report. 

Select the Fields, Graphics and Transmit Reasons you want to see 

in the report in the respective fields. 

From the Repeat dropdown list, select if you want the report repeated 

Daily, Weekly or Monthly. 

Use the Start time and End time dropdown lists to select the time at 

which you want to generate the report. 

The Send to field is populated with the default email address for the 

account. You can change this address or add additional email addresses, 

separated by a semicolon. 
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Click Apply. The report schedule is saved and added to the list of 

scheduled reports. 

 

 

 

To modify a scheduled report, in Reports, click Schedule. In the 

Details section, under the Generate column, click the link of the report 

schedule you want to modify. The Report Scheduling page appears. 

Modify the report schedule as required. Click Apply. The modified 

schedule details are saved. 

 

To delete a scheduled report, in Reports, click Schedule. In the 

Details section, under the Generate column, click the link of the report 

schedule you want to delete. The Report Scheduling page appears. Click 

Delete. The scheduled report is deleted. 
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Profile 

The Profile section shows your profile details that were created when you 

purchased your devices. You can view and modify these details as required. 

 

To view or modify your profile, click the Profile tab, and modify the 

information as required. Click Apply. The changes are saved.  
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Using Map Tooltip Format 

The Map Tooltip Format field lets you configure the information that will appear 

in the info window on the Map page when you select a device. 

To see all the parameters that can be configured in the Map Tooltip Format 

field, click on the green question mark located to the right of the field. The Map 

Tooltip Format legend window will appear. 

 

Once you made all the necessary changes, click Apply. Then go to the Map 

page and check the device info window. 
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Help 

The Help section contains answers to some frequently asked questions and 

Starcom Online tutorials. 

 

 

 

Click on the appropriate tab to access the necessary information. 
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Appendix A – Device Communication in Starcom 

Systems 

 

WatchLock Cube is the component of Starcom’s advanced tracking and 

monitoring system. The system uses advanced software algorithms for field 

tracking of devices and provides customers with a selection of real-time 

information about the tracked device. The following image illustrates the 

Starcom Systems communication channels. 

 

 

 

The device transmits messages according to the values specified in WatchLock 

Parameters > Transmission Rates settings (GPRS, SMS). 
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When the device’s modem is turned on, it tries to connect to the network and 

transmit via GPRS (4 attempts: 2 on the first server and 2 on the second 

server). If it fails to connect to the network, it will switch to the SMS channel 

(if it is configured to transmit via SMS) after about 4 minutes, because it makes 

four attempts to connect via GPRS. It will constantly try to transmit via SMS. 

The next attempt to transmit via GPRS will be repeated in 5 minutes. Every 5 

minutes, the device will attempt to connect to the network and transmit via 

GPRS. This process is illustrated in the following figure. 

 

 

 

The device saves all the information that could not be sent in its memory. Once 

it is able to connect to the network again, it will transmit all the stored data. 

The device sends encrypted data to the routing server. When the routing 

receives it, it is decoded and encoded at the same time and sent to all the 

recipients configured in the system. 

 

The message size is 140 bytes (70 bytes data and 70 bytes header). 

 

For more information, see Routing, Control Center and SMS Notifications 

guides. 
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Appendix B – Maintenance 

 

Use OKS 1133, Low-Temperature Silicone Grease, to lubricate the pins and the 

spring.  
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Appendix C – Contacts 

 

For more information about Starcom Systems Company and products, please 

visit: http://www.starcomsystems.com. 

 

Technical Support 

Comprehensive support information is available online at: 

http://wiki.starcomsystems.com/wiki/index.php/Support. 

 

Should you have any questions regarding our system, please contact Starcom 

technical support. For personalized support, use Email: 

support@starcomsystems.com, or Skype: starcom.support. 

 

http://www.starcomsystems.com/
http://wiki.starcomsystems.com/wiki/index.php/Support
mailto:support@starcomsystems.com

